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INTRODUCTION  TO OPEN DRAGON

1.1 What is Open Dragon and What Can It Do?

Open Dragon is a software package for personal computers that displays and manipulates images, i.e.
visual representations of data. Although Dragon can be used for a variety of different types of visual
information, it is oriented primarily toward processing remotely-sensed images. The following section
explains remote sensing image processing and discusses Dragon’s image processing capabilities from
a remote sensing perspective. 

1.1.1 Remote Sensing Image Processing

Remote sensing is gathering information about some object from a distance. In most common uses of
remote sensing, the object is the earth, or some part of it, and the information gathered is measured
levels of electromagnetic radiation reflected or emitted from the earth at various locations. A variety of
sensing instruments can be used to measure and record this radiation, depending on its wavelength.
The most commonly-used sensors are aircraft-borne cameras and scanning radiometers mounted on
satellites orbiting the earth. 

Remotely-sensed data are routinely used for investigation, management and monitoring in a wide
variety of fields: meteorology, forestry, oceanography, exploration geology, hydrology and water
resources engineering, agriculture, etc. Electromagnetic radiation levels can provide information on
vegetation density and species, rock and soil types, water temperature and turbidity, settlement
location and intensity, and many other important physical and social variables. Remote sensing makes
it possible to view and evaluate conditions in a relatively large spatial area, at a relatively low cost
compared to ground surveys. 

Cameras and scanning radiometers measure the levels of radiation (visible light or infrared) distributed
over some area of interest. The data gathered by these devices can be maintained and presented in
either digital or visual form. In digital form, the measurements are represented by a set of numeric
values, one number per resolution element or pixel (the smallest area from which a measure of
radiation can be obtained.) The same measurements, however, can also be considered as a visual 
image. An image is a two-dimensional "picture" of sensed radiation levels; positions on the image
correspond (more or less) to positions on the earth, and the brightness of the image at any position is
proportional to the amount of radiation measured at that point. 

A visual image is the primary representation provided by a camera. For traditional cameras that use
photographic film, special devices (called scanners or frame grabbers) are necessary to transform a
photograph into digital form. For data gathered by digital cameras, or aerial or space-based
radiometers, the digital form is usually primary. A variety of computer-based devices can be used to
turn this digital data into a visual image. 

Both digital and visual image representations of remotely sensed data have certain advantages. Visual
images are relatively easy for humans to analyze and interpret. The visual representation makes it
possible for the human analyst to see spatial patterns in data and recognize objects or areas based on
their appearance and spatial relationships. This sort of global relational information is difficult to
extract from a set of numbers. However, there is information in a remotely-sensed image that is not
directly available to the human perceiver. Distortions, sensor defects and other sources of noise mask
some of the information in an image. Important patterns of information exist that can be detected only
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by combining data from several wavelengths of reflected radiation. Manipulations to minimize noise
or reveal multi-dimensional patterns are difficult or impossible to perform optically or
photographically on the visual form of the image. Such manipulations are relatively easy to perform on
the digital form of the image data, using a computer-based digital image analysis system. 

A digital image analysis system is a combination of computer hardware and software that can display,
transform and combine image data so that the human analyst can extract as much information as
possible. The system maintains and manipulates data in numeric (digital) form, but displays it in visual
form. The flexibility and speed of computers makes it possible to try different image combinations,
different color assignments, and different noise reduction techniques. The computer can also be used
to search for multi-dimensional patterns not visible to the human eye. 

1.1.2 Image Processing for Other Applications

Although Dragon is intended primarily for remote sensing work, it can be effectively applied to image
analysis in other fields. Techniques used for medical image processing, for example, are essentially the
same as those common in remote sensing. Only the vocabulary differs. Dragon will be less useful in
domains such as graphics arts or computer-aided design. Although the system does include capabilities
for overlaying and combining several images, it has only a few facilities for line drawing or definition
of visual objects. Basically, Dragon can be applied in contexts where image information gathered
from some outside source needs to be improved, modified, and combined with other image-like
information. 

1.1.3 Dragon Image Processing Capabilities

This section summarizes the image processing capabilities available with Dragon. It assumes that you
have some familiarity with digital image processing techniques and terminology. For more
information about these capabilities, you can consult the chapters on individual Dragon operations
and the resources listed in the Bibliography. 

When Dragon was first developed, the graphics capabilities of personal computers were severely
limited. Currently available graphics hardware allows Dragon to provide very high quality image
display. In general, Dragon can display images up to 1024 x 1024 pixels, in as many 16 million
colors. Much larger images can be viewed and processed by subsampling them to the required size.
The FCONVERT  and TIF2DRAG  utilities provide an automatic subsampling and data extraction
capability. 

Dragon has capabilities for displaying single-band images in color or gray-scale form. It also includes
three-band color composite and image overlay capabilities. Dragon provides facilities for adding titles
or labels to screen images and for displaying legends on classified images. The user can explicitly
control contrast stretching and color assignment or allow Dragon to handle these processes
automatically. 

Most common enhancement operations are available in Dragon, including band sums, ratios and
differences, edge enhancement, smoothing and arbitrary 3x3 filters. A few more unusual enhancement
capabilities are also provided: symmetric differencing, relaxation, and masking. The results of each
enhancement operation remain available so that multi-step computations such as vegetation indices
can be accomplished efficiently. Images created by any Dragon operation or imported from outside
sources can also serve as input to enhancement processes. 
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Dragon supports density slicing, supervised classification using boxcar (parallelepiped), minimum
distance to mean, and maximum likelihood algorithms, and unsupervised clustering. Training samples
are selected interactively and can be saved, examined, combined, and modified. Training area
boundaries can also be saved and then applied to a new image. This allows identical areas to be used in
two separate classifications (e.g. in multitemporal studies). The resulting image can be modified by
combining or recoding classes. Dragon provides control over colors assigned to classes. Classified
images can be visually overlaid on the original image or combined with the original using the masking
option to assist in the interpretation of class contents. 

Dragon also includes facilities for geometric correction and registration, and for point, line, and
polygon operations. The geometric correction operations consist of interactive ground control point
selection, calculation of image transformation equations, and resampling of the image. Point, line, and
polygon operations include provisions for creating linear feature overlays, for extracting polygonal
subimages ("cookie cutter" operations), and for measuring linear features. 

Finally, Dragon offers a variety of utility functions including: image subsetting, histograms,
scatterplots, display and modification of identifying information in image file headers and saving of
images. 

A variety of stand-alone programs are available for use with Dragon. These include programs for
exchanging data with other remote sensing and GIS systems, and for exchanging both raster and vector
data with other computers. 

The basic capabilities of Dragon can be augmented by means of special-purpose routines created by
the individual user. This possibility is discussed in more detail in the Getting Images In and Out
chapter, and in the manuals supplied with the Dragon Programmer’s Toolkit or the libdtk  libraries. 

1.2 Overview of This Manual

Dragon Documentation

The User Manual is the primary documentation for the Dragon software system. The complete and
most up-to-date version of the User Manual is provided in machine readable form as a set of .HTML
files, and a reader program supplied with Dragon provides convenient access to this manual. You can
also view the individual files using any browser such as Netscape. 

In addition to the HTML version of the User Manual, you may find a printed copy of some parts of the
manual. Note that the printed copy is not the complete user manual and, in addition, may be less
up-to-date. The printed version is provided only as a convenient introduction to the Dragon system. 

Additional documentation in the form of Technical Notes, Release Notes or Installation Instructions
may be distributed with the software from time to time, in either printed or computer-readable form.
Check the Dragon distribution disk(s) for any files called READxxx.ME  or READxxx.HTML .
These will contain the most up-to-date information on using Dragon. A newsletter called DracoNews
is published on an irregular schedule, to keep users informed about new releases and other events of
interest. 
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The ManReader Application

Dragon includes an application specialized for reading the Dragon User Manual. This application,
called the Manual Reader, is an enhanced HTML browser that knows about the structure of the 
Dragon documentation. The Manual Reader is used to provide context-sensitive operation-specific
help within Dragon. However, it can also be used in a stand-alone mode to browse the manual as a
whole. 

You can run the Manual Reader either from the computer’s Start menu (Start->Dragon->User 
Manual), from the command line, or from within Dragon. To run the Manual Reader from the
command line, switch to the Dragon system directory and type: 

        ManReader

The Manual Reader has three tabbed panes. The leftmost tab, labeled Contents, displays a table of
contents in a tree-structured form. When you select a topic from the tree, the center tab, labeled 
Description, comes to the front, showing the text of the currently-selected topic. Buttons at the bottom
of the application allow you to navigate to the next or previous topic in the document. 

The third tab, labeled Details, is enabled only for sections of the manual that describe specific Dragon
operations. In these cases, clicking on Details will display a table showing all the parameters
associated with the operation, with their meanings, defaults, and the Dragon command language code 
(parameter specifier) for each one. If the topic displayed in the Description pane does not relate to a
specific Dragon operation, the Details tab will be disabled. 

When the Details pane is displayed, the Previous Topic and Next Topic buttons are disabled. You
must return to one of the other panes to select a new topic. 

The Manual Reader can be accessed from inside Dragon by choosing Help->User Manual. If the
Manual Reader is not already visible, it will be activated. Then, if Dragon is currently displaying the
data entry screen (response panel) for a particular Dragon operation, the Manual Reader will
immediately display the Description pane for that operation. Otherwise, the Manual Reader will
simply display the table of contents tree. 

This manual is designed to be accessed via the Manual Reader. This is the only way you can gain
access in a context-sensitive manner to the detailed parameter information for each operation.
However, the manual is actually a set of HTML files, and it can be read using a standard Web browser
such as Netscape or Internet explorer. To access the document in this way, point your browser to the
file doc\index.html within the Dragon system directory. This will bring up a simple list of links to
each chapter. 

Assumptions about the Reader

This manual assumes that you, the reader, know something about digital image processing principles,
techniques and terminology. As an educational tool, Dragon is intended to be used along with, but not
to replace, a textbook on remote sensing image processing. The description of each individual
operation explains briefly what the operation does, but it assumes you are familiar with the underlying
concepts and assumptions. If you need further information on basic image analysis issues, we
recommend that you consult references in the Bibliography for more in-depth treatment. 
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The manual does not assume you have had any previous hands-on experience with a digital image
processing system. However, it does require that you have a basic understanding of how to use your
computer and your operating system. You should know, for example: 

How to start up the computer and the operating system 
How to use the mouse 
How to insert, remove, and handle CDROMs 
What a file is; how to find out what files you have available; how to name, rename, copy, and
delete files 
How to run programs 
What subdirectories and paths are and how you use them 

You do not need to know anything about programming or programming languages to use Dragon.
Once again, the Bibliography can provide you with resources if some of the topics above are
unfamiliar to you. 

Manual Organization

This manual is organized in three general parts. First, there is this introductory chapter, which provides
an overview of Dragon and covers a number of important preliminary topics. In particular, this
chapter describes some important operating concepts that you must understand to use Dragon
effectively. It also discusses in detail the various ways in which you interact with Dragon to perform
image processing tasks. These initial topics are essential. Regardless of your level of experience with
computers and image processing, you should read this chapter first. 

The second part of the manual consists of six chapters that describe in detail all the operations
available in Dragon and how they are used. The six chapters correspond to the six main functional
divisions in Dragon: display operations, enhancement operations, classification operations, geometry
operations, utility operations, and file handling operations. Each chapter begins with a general
overview that summarizes the capabilities within that functional division. This is followed by separate
sections for each operation. These individual sections describe what the operation does and make
suggestions for its most effective use. If you are accessing the manual via the Manual Reader
application, these chapters also provide access to a detailed table of all options and possible choices
involved in using the operation, as discussed above. 

You may use this second part of the manual in various ways, depending on your experience with
digital image processing techniques and systems. If you are relatively inexperienced, you should
probably read the chapter overview and operation descriptions first, to get a unified picture of what
operations should be used for what purpose. Later you can go back and study the details of each
operation. If you are fairly experienced with digital image processing systems, you can use the Table
of Contents to locate the operation you need, and consult that section directly for details on how to use
it. The operations are described in this manual in the same sequence that Dragon presents them to you
in the menus. 

The third part of this manual consists of five chapters on more miscellaneous topics. These include
data transfer into and out of the system, and use of Dragon’s script capability, which allows an
ordinary text file to control the operation of Dragon without any user input. The script capability is
particularly useful in an educational environment, for construction of demonstrations and
partially-automated tutorials. If you are an instructor, a laboratory supervisor, or simply an advanced 
Dragon user, you should read this material. However, it is not essential for running the basic Dragon
system. 
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The third part also includes a chapter that describes many of the file formats used in Dragon. You
should consult this section if you need to write a program to convert data from some other image
processing system for use with Dragon. Finally, there is a chapter documenting several command-line
oriented utility programs that are distributed with Dragon, and a a Bibliography chapter, which
suggests some references for further information on image processing and computers. 

1.3 Dragon Image Processing Concepts

1.3.1 Images and Image Files

Dragon is a program that processes image data. For Dragon’s purposes, an image is a
two-dimensional array of numbers, each number associated with a position in the array. Positions in
this array are called pixels. Each pixel can be identified by a set of coordinates. In Dragon, the vertical
coordinate is usually called the line number; the horizontal coordinate is called the pixel number. (Both
the line number and pixel number coordinates start with a value of zero at the upper left corner of the
image.) The maximum possible values of line and pixel number depend on the particular image. The
pixel number at a particular point on an image is also sometimes referred to as the point’s X coordinate
while the line number is the point’s Y coordinate. 

Image data in the Dragon system are stored in image files. The image files contain the data values for
each pixel, line by line. Image files are normal operating sytem files: you can copy them, rename
them, delete them, etc. 

Image files in Dragon can have any name up to 32 characters long (without any embedded spaces).
However, all image files must have the extension (filetype) .IMG  so that Dragon can recognize them.
Normally, the name you give to an image file should tell you something about what the image data is
and where it came from. For example, you might call a file holding aerial photography data from
Bangkok BANGKOKPHOTO.IMG . 

One common type of image data that you will use with Dragon will be satellite image data gathered
with scanning radiometers such as the Landsat TM instrument. These sensors usually measure
reflected radiation in several different wavelengths, often called bands (or, in some books and image
processing systems, channels). Thus, a complete set of satellite data for a particular scene will actually
consist of several bands, all acquired simultaneously. Such data is called multispectral. Multispectral
data is useful because some kinds of ground cover reflect very little radiation in some wavelengths and
a great deal in others. Thus, a particular ground cover type can be identified by its pattern of radiation
levels across different bands (its spectral signature). 

In each band of a multispectral scene, a particular pixel (identified by a specific set of image
coordinates) represents the same location on the ground. Because of this property, all the bands of a
multispectral scene are said to be registered. Registration is an important consideration in digital
image processing. It normally does not make sense to combine two images if they are not registered,
since you may be combining data from two different locations. Images of the same geographic area
acquired at different times usually will not be registered. It is possible to perform a mathematical
transformation on one image to register it to another. 
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Note

In some image processing systems, data from all the bands of one scene are stored together in the
same file. This can result in very large files. In Dragon, each band of a scene is stored in a
separate image file. You must explicitly decide which bands to include or exclude in any
operation. 

Since you frequently want to process several bands of the same scene together, it is important to know
not only which scene but also which band the data in a file represents. We recommend that you use a
standard method for naming your image files, such as reserving the last character in the file name for
the band number. For files that represent the same scene, all other characters in the name would be the
same. Thus, BANGKOK1.IMG , BANGKOK2.IMG  and BANGKOK4.IMG  would be appropriate
names for three bands of a multispectral image of Bangkok. 

1.3.2 Image Header Information

In addition to the data values for each pixel, every Dragon image file contains a block of identifying
information called the header. The information in this header is used to keep track of where image
files came from, what they represent, and what processing they have received. 

The different items of information stored in the image file header are called header fields. Dragon
provides you with capabilities for examining header fields and for changing many of them. (See the
chapter on Utility operations.) The most important header fields that you can list and/or modify are: 

Identifying  Fields

Number of Lines: How many lines are in the image represented by this file 

Number of 
Pixels/Line:

how long each line is, in pixels 

File Type: I if normal image file, C if classified image L if GIS layer or rasterized
vector file. 

Scene 
Identification:

a text label that describes the primary location from which the data was
recorded (should be the same for all bands of a given scene) 

Subscene 
Identification:

a second text label that identifies a subset of the primary location from
which the data was recorded (should also be the same for all bands of a
given scene) 

Band Number: a label, usually but not necessarily a number, that identifies the band (if any)
the image represents 

Source: a three-character code identifying the Dragon operation that created the file 

Comment: a 45-character phrase with any additional identifying information you wish
to enter 

Color File Name: Optional name of color scheme file to be used by default in displaying the
image. 
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Statistical Fields

Mean value: arithmetic average of data in file, to nearest whole number 

Maximum value: largest data value in file (range 0 to 255) 

Minimum value: smallest data value in file (range 0 to 255) 

Variance value: a measure of the "spread" of values around the mean 

Standard 
Deviation:

another measure of spread 

Histogram: table of frequencies counting how many pixels there are in the image that
have each possible value 

Special Fields

Names for each 
class:

Labels for classes that have been identified in the image 

Georeferencing 
information:

Fields that define the relationship of the image coordinates to an external
coordinate system. 

Calibration 
information:

Fields that define a mapping between image data values, which range from
0 to 255 or 0 to 65,000, to some external measured quantity, such as
temperature or elevation. 

Dragon recalculates image statistics after any operation that could change image values, and generally
tries to maintain the header information in the computer memory in a correct state. Dragon uses the
identifying fields in the header for checking logical consistency in multi-band operations, and the
statistical fields for computing automatic contrast stretch parameters, density slicing boundaries, etc. 

1.3.3 Image Memory and the Main Memory Image

Dragon can only operate on data available in the computer’s random access memory (RAM). Image
data are stored in image files when they are not being used. Therefore, the data must be read from the
disk into memory in order to be displayed or manipulated. 

Dragon’s operation depends on the concept of a main memory image. All operations on images are
considered to take place in the main memory image area, and all results are left in the main memory
image. Consequently the main memory image always holds the results of the most recent computation.
This is a central concept in the organization of Dragon. 

The main memory image is very convenient because it lets you chain together a series of operations
without having to write intermediate results out into files on your disk. Suppose, for example, you
wanted to add together two image bands, and then subtract a third from the result. You would choose
the operation for adding image bands and tell Dragon what image files held the data. Dragon would
read the first set of data into the main memory image, then read and add successive lines from the
second set of data. The result of the addition would be left in that memory image. Next you would
choose the operation for subtracting one image from another. This time, when Dragon asked you what
files held your data, you would select the current image in memory (referred to by the "special
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filename" =M) for the first set of data. There would be no need to save the results of the addition in an
image file and then read that data back into memory for the subtraction. Memory images make the
sequence of operations quite efficient. 

Note

Earlier versions of Dragon actually maintained a particular chunk of computer memory for use as
the main memory image. In the current version of Dragon, the notion of the main memory image
should not be assumed to be a literal description of the system. However, from a conceptual
perspective, the current Dragon version works exactly the same way as previous versions. 

1.3.4 Coded Image Files

A standard image file is assumed by Dragon to be radiometric data derived from a sensor. The
numbers which represent each image element are therefore physical measurements of the emitted or
reflected radiation received by the sensor, and arithmetic operations (such as histogram normalization)
can be reasonably to these measurements. 

Some files, however, have the same structure as radiometric image files, but the numbers are codes or
category labels rather than true physical measurements. They may carry order information but never
magnitude information. For this reason, it does not make much sense to perform arithmetic operations
on such coded images. Dragon refers to these files as coded image files, and processes them slightly
differently than radiometric image files. 

Structurally, a coded image is identical to any other image: a two dimensional array of numeric values,
where each pixel value is associated with some position on the ground. Dragon will not stop you from
performing arithmetic on coded files, but it will warn you that you are doing something unusual. 

Coded image files can arise in several different ways. For example, a classified image results from
applying a classification procedure to one or more image bands. A classified image is distinguished by
having a C in its header File Type field, and by having associated class names. 

When Dragon displays a classified image, it will not perform any default contrast stretch (since that
would change the class values). Also, a classified image has its own associated color scheme, created
when you save the image after performing a classification. This special color scheme, which can be
modified using the Utility->Colors  operation, is always used to display the classified image in color
unless you explicitly request a different color scheme. 

A rasterized overlay image can be generated using the Geometry->Vector operations, and a coded
layer file may be imported from a Geographic Information System (GIS) package. These are both
characterized by having an L in the header File Type field, and by including somewhat different
ancillary information than a classified file. 

Dragon uses the File Type field in the image header to determine whether an image is coded or not. If
you want to perform some unusual operation such as a contrast stretch on a classified image, you can
do so by changing the value of the File Type from C to I. This will "fool" Dragon into treating the file
like a normal image. Likewise you can make a normal image look like a classified image to Dragon
by changing its File Type to C. Dragon permits you to do almost any sort of bizarre processing, but
tries to protect you from doing so by accident. 
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1.3.5 Mask Images: Processing Subregions of Images

Many of the Dragon analysis and classification operations can be limited to specified subregions of
the image data. These regions, which are defined by a mask image, can be arbitrarily complex in shape
and contain numerous disconnected regions. In general, you can think of the mask image being
overlaid on the image data. Wherever the mask image is zero, the image data is ignored and the
resulting image will have zero value. Where the mask image is not zero, computation proceeds as
usual. 

Because the mask data need not have the same dimensions (number of lines and pixels) as the image
data, an arbitrary choice must be made about image data outside the mask image area. In most
operations, pixels which are completely outside the mask image are treated as though the mask were 
not zero. 

The Classify->Recode operation uses the mask image slightly differently. In this operation, pixel
positions where the mask image is non-zero, as well as any which are outside the area of the mask
image, will be recoded. Positions where the mask image is defined and is zero are left unchanged. 

The Utility->Histogram  operation also allows you to specify a mask image. If you do specify a mask,
the histogram calculations include only the pixels where the corresponding mask image pixel is
non-zero. Among its other uses, this function allows you to see a histogram of the raw data values of
only those pixels which were classified as members of one particular class. For example, to see a
histogram of the water pixels in your image, create a mask image using Classify->Recode based on
your classified image with all non-water pixels recoded to zero. Then specify that mask as the mask
image in Utility->Histogram . 

All of the operations which permit use of a mask image (generally, most of the Enhancement and 
Classification operations) provide a field to specify a mask image file name. If this field is left blank,
no mask will be applied. 

1.3.6 Color Schemes and Color Files

A color scheme, in Dragon terminology, is an association between each of the 256 possible image
data values (0 to 255) and the color in which pixels with that value should be displayed. A color
scheme may assign the same color to more than one data value. Frequently a contiguous range of
values will be assigned to the same color, for example, all values between 16 and 31 might be assigned
to light-green. You can, however, assign the same color to dissimilar image data values. This sort of
color scheme is frequently used for special effects. 

Color schemes are stored in color files until they are used. Color files can have any name up to eight
characters long. Their extension (filetype) must be .CLF. You should not create or modify any color
files with names of the form DEFxxxxx.CLF. These are standard color files that Dragon uses in
various operations. 

Dragon includes an operation for defining and modifying color schemes and saving them in color files
Thus, you can have control over the color assignments in your images. On the other hand, Dragon has
a set of standard color schemes that often provide good results. You do not have to define your own
color schemes unless you want to achieve some particular effect not possible with the standard
schemes. 
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Using Utility->Header , you can store the name of a color file in the header of an image file. Then 
Dragon will use that color scheme, by default, whenever you display the image. Classified images
always include the name of a color file in their headers, as discussed in above. Note that Dragon
assumes that a color file recorded in an image file header is located in the same subdirectory as the
image itself. 

1.3.7 Other Dragon Files

There are several other kinds of data files used in Dragon. Information on the structure of the files
listed here, and other files used by Dragon, is included the File Formats chapter. 

First, there are signature files. Signature files store training signature statistics, values that are used to
guide the classification process by defining "typical" values for each class. Signature files are created
by the Classify->Edit Signatures->Save signature operation, in Classification. These files can have
any file name (no embedded spaces), but their extension (filetype) must be .SIG. 

The second type of subsidiary file is the polygon file. Polygon files record the boundaries of training
areas selected in the Classify->Training operations Polygon files can have any file name but must
have the extension .PLY. 

Another kind of file used by Dragon is a script file. A script file is a text file of Dragon commands,
created with any word processor or editor. Dragon’s script capability makes it possible to execute
almost any series of commands automatically, without any user interaction. There are a few rules that
must be followed, but for the most part, commands can be included in a script file in the same format
as if you typed them on the Dragon command line. (See the section below on Dragon User Interface
Script files can have any name, but must have the extension .SPT. 

Dragon vector files, which have the extension .VEC, are used to capture the coordinates and attributes
of lines and polygons created in Geometry->Vector. The captured data can be exported to other
software packages which use vector data, or they can be read by Geometry->Vector to become the
basis for creating additional vectors, or to be transformed into a raster data layer. 

Recent Dragon versions have a new file type called a recoding table file. These files may be used in
combination with the Classify->Recode operation to provide an arbitrary remapping of image data
values. Refer to the chapter on File formats for details. 

Another new file type is the measurement data file. Measurement data files are used to capture in
detail the data which are displayed by the line profile and area histogram displays in the 
Geometry->Measure operation. These output data files allow you to do statistical or graphical
analyses on image data gathered from Dragon, using spreadsheet, statistics, data base, or presentation
graphics software. The file format for the output data file is a generic comma-delimited form that is
intended to be easy to import into other packages. 

There are three types of files that Dragon uses or creates as part of the process of generating
coefficients for geometric correction or registration. The most important are coefficient files, which
have the standard file extension .COF. Coefficient files are used to record the regression coefficients
calculated by Geometry->Calculate. They serve as a primary input to the Geometry->Register
operation which actually performs the geometric correction/registration process. 

Ground control point files (with the standard extension .GCP) record coordinates and user-defined
labels for ground control points. GCP files can hold either image or map coordinates. They are created
as an output of the Geometry->GCP operation, and serve as input to Geometry->Calculate. 
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Finally, Geometry->Calculate creates a report file that records the details of the regression process.
This report file has the standard extension .OUT. 

Dragon also creates a number of kinds of files during processing. In general, the detailed structure of
these files is not important to the user and has not been included in this manual. 

One special category of file which Dragon creates are those with any file extension including one or
more dollar signs ($). These files are intended to be temporary; that is, they are usually deleted
automatically by the Dragon software. If you see any of these files in your directories, when Dragon
is not running, you may delete them without loss. On the other hand, you should not delete any such
files while you are using Dragon ; this might create serious problems. 

1.3.8 Filenames and Special Filenames

1.3.8.1 Structure of a Filename

The complete name of a file, under the MS-DOS and Windows operating systems, has the appearance 

        C:\PPP\AA\TTTT\HH\NODENAME.EXT

This name consists of four parts: 

The drive letter, shown as C in the example, is the disk drive where the file resides. The drive
letter is followed by a colon (:). 
The path, shown as \PPP\AA\TTTT\HH\  in the example, consists of a list of directories and
subdirectories separated by the backslash (\) character. This path specifies the location in the
directory tree on the specified drive where the file is located. 
The node name, shown as NODENAME  in the example, is the name which actually identifies
the desired file. Usually, when one refers to a file name, one is talking only about the node name
portion. In Windows, node names can contain almost any character, including blanks. When you
create or use files in Dragon, we strongly recommend that you avoid using special characters
other than underscore or dash in your node names, and that you keep node names to 32 characters
or fewer. You should never create files for use with Dragon whose node names include
embedded blanks. If you need to specify a file or path which does include embedded blanks, you
may need to enclose the entire name in quotation marks (" ). 
The extension is the final part. All of the standard extensions used in Dragon are limited to three
characters, but this is not a requirement. The extension provides some additional identification of
the particular file. However, by custom, the extension is used to distinguish particular types of
files. For example, as discussed previously in this section, the file extensions .IMG, .CLF, .PLY, 
.VEC, and .SPT (among others) all have special meanings to Dragon. 

1.3.8.2 Selecting a File by Name

There are many times while using Dragon, when the user must specify a filename to Dragon. For
almost all operations, the Dragon software already knows the drive, path, and extension portions of
the name. Thus, you only need to enter the node name portion of the filename. You may, if you wish,
provide the full drive:path\nodename form in order to access files which would not otherwise be
available. Usually, you do not need to specify the file extension. 
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As discussed below, the Dragon menu system also allows you to browse through the files on your
hard drives in order to find and select your desired file. 

1.3.8.3 Special Filenames and the STATUS Window

Whenever Dragon permits you to specify the name of an image file to read, you are being asked
which data the software should operate on. Frequently that data is stored in a file on your hard disk, or
on your network. However, Dragon also permits you to operate on data already "in memory". 

Dragon provides several memory images which you can use as input in some operations. You tell 
Dragon to use one of these as the source for your operations through special filenames. A special file
name is a sequence of characters which would be illegal as a real file name. The most important ones
are listed below. 

The =M  (the ’M ’ stands for the English word main) memory image contains the results of the
most recent image analysis operation. This means that all Enhance operations, and all 
Classification and Geometry operations which produce an image result, place that result into 
=M . Because =M  can be used as the (or an) input to most of these operations, it is very easy and
fast in Dragon to chain a sequence of operations on the same data. In addition to the analysis
operations, the Display->1 Band, Display->Gray, and Display->Overlay operations, when
reading from a disk file, also load that file into =M . 
The =R (Red) memory image contains the image which was assigned to the red color plane
during the most recent Display->3 Band operation. =R can be the input to most display and
many analysis operations. 
The =G (Green) memory image contains the image which was assigned to the green color plane
during the most recent Display->3 Band operation. 
The =B (Blue) memory image contains the image which was assigned to the blue color plane
during the most recent Display->3 Band operation. 
The special filename =C does not correspond to a single memory image, but rather to the
collection =R, =G, and =B. =C (the ’C’ stands for the English word composite) provides a
convenient way to use a multi-band image as a reference or background for operations such as 
Utility->Cursor  and Geometry->GCP. Note that it does not make any sense to specify =C as
the input to an analysis operation. 

In all cases, the memory images contain the true data values with no stretch applied. Thus, it is very
fast and easy to experiment with viewing the effects of the different stretch algorithms supplied. For
those operations which permit you to specify a composite image (=C), the composite image is
displayed using the same stretches which were most recently used for Display->3 Band . 

There may be times, however, when you want to change the image values (for example, by applying a
histogram stretch). Classify->Recode provides some very powerful capabilities for doing this. The
results of such a stretch can be saved as a new image using File->Save. 

Not every operation or image file name field will accept every special filename. Generally the
limitations are reasonable or obvious; however, the Help message for each field tells you which ones
are permitted. 

Of course, you also cannot specify a name of a special file if the corresponding memory image has no
image loaded into it. To help you to remember which images are loaded, Dragon provides a Status 
display listing the memory files as well as other information. To see the Status window, press <F6> or
click on Status radio button with your mouse. The Status window, when it is visible, replaces the Help

chapt1.html page 13 at 11 Jan 2006  16:21



display. You can return to the Help display by pressing <F4> or selecting the Help radio button. 

How Dragon Finds a File

There are two types of files which Dragon needs to be able to locate: 

Dragon system files, a category which includes the executables, help files, configuration files, and
various other kinds of files. 

Data files, including all image, script, signature, vector, polygon, and registration files, plus most color
files. 

The system files are almost never specified by name during normal use: the file names are built into 
Dragon. In order for Dragon to function properly, these files must all be in the currently-logged drive
and directory while Dragon is executing. (If you do need to access or name one of the system files,
you must include a path specifier consisting of ".\ "). 

Dragon also uses various kinds of data files. To assist you in organizing and accessing your hard disk, 
Dragon provides a facility for a default image path or default data directory. This is a drive and path
specification where Dragon will automatically look for any input file which you may name. 

For example, if the default data directory is C:\IMG\  and you type, in answer to some question
requesting an image file name, a file name of BANGPHOT , Dragon will look for the file 

        C:\IMG\BANGPHOT.IMG

If the file is not actually located in the C:\IMG\  directory, your will receive an error message saying
the file cannot be found. If, in fact, the file is on some other directory (for example, on 
C:\LANDSAT\) , you would have to specifically name the directory by typing 

        C:\LANDSAT\BANGPHOT

You must specify a value for the default data directory during the installation of the Dragon software.
The default data directory can be changed while Dragon is executing by use of the 
File->Preferences->Paths command. 

There is also a default location, where Dragon will create new data files. Like the default image path,
the initial value for this path must be specified during the installation process, but can be changed via
the Preferences submenu. Sometimes it is useful to have these two paths refer to the same location, so
that you will automatically be able read files that you write, without changing the directory
specification. 

1.3.9 Local Area Networks (LANs)

Local area networks provide a facility for high-speed communication between numerous different
computers, all located fairly close together (hence the term "local area"). Different local area networks,
or LAN s as they are commonly called, provide different services, or capabilities. A LAN is almost
always implemented in coordination with the operating system of the local computer, so that the
services provided are generally both extensions of, and limited by, the operating system itself. 

Although a LAN may interconnect several, even dozens, of different computers, the user is generally
concerned with only two of these computers: the one he/she is using (the local computer or 
workstation), and one other which is providing the LAN services being used (the server). It is
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generally not necessary for the user to know which actual computer is the server, although on
sophisticated LANs there may be several servers to choose from. If you have any questions about your
LAN configuration or capabilities, contact your local Network Administrator (a human being) for
information. 

Among all the services a modern LAN can provide, Dragon uses only one: the file server. This
capability permits Dragon to use files (both Dragon system files and data files) which are located on
the network server rather than on the hard disk of the local computer or workstation. In this way, the
network has to maintain and store only one copy of the numerous and large data files found in image
processing, rather than keeping a copy of these files on each computer. Of course, there is some cost to
balance this benefit: a network is much more complex to administer than a collection of isolated
computers, and the data access may also be slower than if all the files were kept locally. 

In order for the local Dragon user to access data files on the network, it is only necessary to specify
the location where these files are to be found. The network generally appears to the user just like an
operating system drive or directory. To access the network data files, simply supply the network drive
and path along with the file name, as described in the preceding section. 

There is one complication here. If several different users are writing files to the network file server, it
is almost inevitable that sooner or later two users will try to write different files with the same name,
or will in some other manner get in each other’s way. Most Dragon data file operations involve
reading, rather than writing, files, so that most operations can be executed over the network without
this problem arising. You should be aware that you may not be permitted to write files to the network
file server. Because of this restriction, we recommend that the default file creation path be set to a
local directory rather than to a LAN address. 

1.3.10 Inputting Data to Dragon 

Digital image data must be made available to Dragon via the normal resources of your computer:
usually either hard disk, floppy disks, or CDROMs. Satellite image data is becoming available in on
CDROM form in many areas of the world including Australia, Japan, and the U.S.A. Furthermore,
drives that can write CDROMS are quite affordable, so that an organization can easily create its own
data CDs. A local area network also provides a convenient way to transfer large data files between
computers. 

The Tools Libraries  are collections of programs available from Goldin-Rudahl Systems which permit
you to import image data in some of the various formats supplied by data vendors. Both SPOT and
TM data are available in these formats in many areas of the world, and other sensor data are becoming
available gradually. These utilities no longer support tape drives. 

Conversion programs are supplied to convert data files from other systems into and out of Dragon
image file format. One of these programs, called FCONVERT , described briefly in the chapters on 
Getting Data In and Out of Dragon  and File Formats, can take any image file that holds binary,
uncompressed 8-bit image data, remove its header information (if any) and add a Dragon header. This
conversion program also allows you to take only a subset of the data in the input file, either by
specifying spatial limits or by taking every second, third, etc. pixel. Thus, you can reduce a large scene
to a size that Dragon can handle, either by focusing on a subarea or by viewing the full area at reduced
resolution. 
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Another useful image data conversion program, also supplied with Dragon is TIF2DRAG . As its
name implies, TIF2DRAG  can import data from the popular TIFF format produced by most image
scanners. In addition, however, TIF2DRAG  can import georeferenced data from Geotiff image files.
Geotiff was created under the guidance of SPOT corporation, and has now been adopted by many
suppliers of remote sensing data. 

1.4 The Dragon User Interface

The term user interface refers to all aspects of an interactive computer program that involve the
two-way communication between the program and the user. Unfortunately, users vary in their prior
experience, knowledge, and ability. Thus, it is difficult to design a single interface suitable for all
users. 

1.4.1 Dragon Interface Components

Interfaces that offer multiple windows on the screen simultaneously, such as Microsoft Windows
variants, Motif, Gnome and KDE, provide great flexibility for the user. Menus can be displayed in one
window; images can be displayed in other windows; messages and text reports can be shown in
transient windows which disappear when the user dismisses them. Current versions of Dragon take
advantage of this flexibility providing a modern, fast, and flexible style of interaction. 

The Dragon interface consists of the following components: 

The Dragon menu client This is a window which
presents a set of menus for
selecting operations within 
Dragon. When a menu item
is selected, typically the menu
client will display a data entry
form, called in Dragon
terminology a response panel,
where you can supply the
parameters necessary to the
operation. The menu client
also provides a window for
displaying help, image status
information or command
history, an optional command
line, and several status areas. 
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Viewports

All images are displayed in
special Viewport windows. 
Dragon provides two
viewports, labeled Viewport 0
and Viewport 1. Most image
processing operations allow
you to select which viewport
to use for displaying the
results. Viewports have their
own menus, which control
image specific operations
such as zooming and printing
images. 

Report 
Windows

A number of Dragon
operations are
available to allow you
to view information
about images,
signatures and so on
as well as graphical,
non-image
information, such as
histograms,
scatterplots and line
profiles. This sort of
information is
displayed in a report 
window. The results
tables created by
classification
operations are also
shown in report
windows. Report
windows can be
dismissed when you
are finished with
them. 

Button Panels Some of the interactive
operations in Dragon, such as 
Classify->Training, display a
floating panel of push buttons
which can be used to invoke
particular actions. The buttons
on these panels are enabled
appropriately depending on
the state of the interaction.
These buttons always have
function key equivalents to
invoke their functionality. 

Query Dialogs Some of the interactive
operations in Dragon also
display simple query dialogs.
For instance, if you click on
the New Class button during 
Classify->Training, Dragon
will display a dialog where
you can enter or select the
next class to train. 
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Error and Message Boxes As is the case with most
Windows applications, 
Dragon uses popup message
boxes to communicate the
existence of error or warning
conditions. Usually these
boxes have a single button,
labeled "OK", for you to
dismiss them. Occasionally,
they will require that you
make a choice (e.g. "Exit"
versus "Continue"). 

1.4.2 Dragon Interface Modes

Dragon’s user interface design accommodates varying levels of skill and experience by providing two
quite different modes of operation within the same program. For users new to Dragon, to remote
sensing image processing, or to computers, the program offers the Menu mode of operation. Dragon
menus gives detailed and explicit information and instructions about each step needed to accomplish a
task. It prompts for each piece of information that you must supply and gives immediate feedback if
you make an error. Menu operations are discussed in the following section. 

The Menu mode offers considerable assistance to a new user. However, experienced users may get
impatient if they must go through prompts in order to accomplish an operation. For these users, 
Dragon provides the Command mode. In Command mode, the program does not prompt for specific
information. You indicate exactly what you want by typing in a command that identifies an image
processing operation plus command parameters that further specify the action: the source of data, the
color scheme to be used, etc. 

In addition to the Menu and Command modes, you can also use Dragon in Script mode. Script files
hold Dragon commands, in exactly the same format you would use in Command mode. 

1.4.3 A Look at Dragon’s Menu System

Most people who have used a computer menu system will have no difficulty using Dragon’s menu
system. The usual keys (the cursor keys, tab keys, <Esc>, and <Enter>) and the usual mouse actions
behave as you would expect. 

The Dragon menu can be presented in a variety of languages other than English. You can change the
language used by accessing File->Preferences->Language. When Dragon is configured for a
language other than English, all menus, prompts, messages, and help will be displayed using that
language, in the appropriate character set. 

Dragon has menus, which are lists of items to select, and response panels, which are data entry forms
to fill out. 

Dragon menus work like those in any other Windows application. Click on the menu to drop it down
and display its items. Use the mouse to click on the item you want, or use the arrow keys to navigate to
that item and hit the space bar to select it. 
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All Dragon menu items have keyboard mnemonics (shortcuts), which are underined in the menu/menu
item label. To drop down a menu, press the <Alt>  key plus the keyboard shortcut. For instance, to
drop down the Display menu, press <Alt-D> . To select a particular item from the currently-displayed
menu, simply type the shortcut letter. For instance, to select Display->Annotation, type <Alt-D-A> . 

Response panels act like standard Windows data entry forms, but have a few additional characteristics. 

Pressing the <Enter> key is equivalent to pressing <Tab> ; it simply causes the focus to move to
the next field, rather than activating the Ok button. This allows you to cycle through the data
fields multiple times before triggering the operation. 
Pressing the down-arrow key is equivalent to pressing <Tab> ; it causes the focus to move to the
next field. Pressing the up-arrow key is equivalent to <Shift-Tab>, moving backwards through
the fields on the form. 
Pressing the <F3> key in a field where a filename is required will bring up a file dialog so you
can browse to the file. You can accomplish the same thing with the mouse by clicking on the
down-arrow graphic at the end of the field. 
Pressing the <F3> key in a field represented by a dropdown list control (also called a "combo
box") causes the choice list to drop-down. 
Pressing the <Home> key in a field that holds some data clears the field. Left and right arrow
keys move the insertion cursor within the field. 
Pressing the <End> key in a field that holds some data moves the insertion cursor to the end of
that data. 
In some cases, the information that you enter in one field will cause changes in other fields when
you tab off the original field. The most common change is to enable or disable other fields. 
To indicate that you are finished entering parameters and want to actually execute the operation,
click on Ok or press the <F1> key. To cancel the operation, click on Cancel, or press either the 
<F10> or <Esc> keys 

The bottom section of the menu client is a multi-function text area. This section can be used to display
help, image status information, or command history. You choose which category of information to
display by clicking on the appropriate radio buttons, or by pressing function keys: <F4> for Help, 
<F6> for Status, or <F7> for history. 

When the Help functionality is active, Dragon displays the help message appropriate to whichever
response panel field or menu item is currently under the mouse (not necessarily the field that currently
has focus). Thus, you can run the mouse from the top to bottom of a response panel and get
information on all the parameter fields, including ones which are disabled. 

When the Status functionality is active, Dragon displays a summary of what image information
corresponds to the special files =M , =B, =G, and =R. This includes the image file names, if the data
have not been modified, and the image dimensions. 

When the History functionality is active, Dragon displays a list of all the commands that have been
executed, in the Dragon command language discussed in the next section. Even if you do not have
History selected, the history information will continue to accumulate. Thus you can switch among the
different information modes (Help, Status and History), without losing any information. 

In additional to the information mode radio buttons, the bar between the response panel area and
information display area contains a checkbox labeled Enable command line. This checkbox displays or
hides the command line; pressing the function key <F2> is equivalent. The operation and use of the
command line is discussed in the next section. 
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1.4.4 Command-Line Operation

The Menu and Command modes of interaction look quite different. However, the logical structure of
operations and the specifying information (parameters) each operation requires are almost exactly
parallel in the two modes. You can move easily from one mode to the other, with a single key. Thus,
you have great freedom in how much of each mode you use. As you learn more about Dragon, you
can start to use the Command mode for some familiar operations while still using Menu mode for
more unfamiliar ones. The choice is entirely yours. 

In Dragon Command mode, you use the same menu choices, operations, parameters and parameters
values as in Menu mode. You just express them somewhat differently. 

All information that you type in Command mode is typed on the command line. To make the
command line appear, click the checkbox labeled Enable command line, or press <F2>. The command
line is a single line text entry area between the response panel area and the help/status/history area. It
is labeled CMD>> . 

When the command line is visible and active, Dragon still allows you to operate the menus. If you
select a new operation from the menu, the command line will disappear and you will be returned to
Menu mode. On the other hand, if there is a response panel displayed when you turn on the command
line, the panel will remain on the screen, with all fields disabled. Even though the fields are disabled,
you can still view the help messages for each field. This can assist you as you work to construct a 
Dragon command in the command line area. 

Command mode input consists of four kinds of items: 

Commands are short sequences of characters that typically are abbreviations of menu labels. All
the top-level menus have single letter commands. Other menu items have three-letter commands.
For example, D is the command to identify the Display operations menu, while 1BA is the
command for the single-band color display operation. 

Note

In current version of Dragon Dragon unlike earlier versions of Dragon, you must include
the menu command in every command string, even if successive commands belong to the
same primary menu. In earlier versions of Dragon, you could execute D 1BA, and then
when that completes, specify the next command simply as GRA (without the D prefix). This
will not work in the current version of Dragon; you must enter a fully-qualified command
each time. 

Parameter specifiers (also called p-specifiers) are codes that identify parameters. All p-specifiers
begin with a dash, followed by one or more letters or numbers. For example, 

-F (Image File parameter) 

-UBP (User-defined Upper Break Point parameter) 

The p-specifier code name is related in a more-or-less direct way to the name of the parameter as
expressed in the response panel prompt string. Similar parameters used with different operations
have the same or similar specifiers, to minimize confusion. 

chapt1.html page 20 at 11 Jan 2006  16:21



Parameter Values are numbers or strings that indicate your selected value for an operation
parameter. The permissible values for each parameter are the same in Command mode as in Menu
mode. In Command mode, you simply type the parameter value immediately after the corresponding
p-specifier on the command line, with at least one space between them, e.g. 

        -F BANGKOK2

If a parameter value includes spaces, e.g. in setting the Comment field in the Dragon header, you
should enclose entire parameter value in quotation marks, e.g. 

        -CMT "TM Band 2 of central Bangkok, uncorrected"

Execute Code : In the Command mode, as in the Menu mode, Dragon does not execute the
operation you have chosen until you are ready. An explicit Execute Code is necessary, since it
may take more than one line of input to specify all parameters. To execute a command in
Command mode, press <F1> or type the following at the end of the command (preceed by at least
one blank): 

        -.

(dash then period) 

Because the Command mode uses an explicit Execute Code, you can change your mind about
parameter values you have entered. Suppose you entered the following command string: 

        D 1BA -F BANGKOK2 -H N

(Notice that spaces or carriage returns must separate each command, p-specifier or parameter value
from the others items in the command string.) This example requests that no histogram stretch be
done. Since the Execute Code was not entered, Dragon does not immediately perform the display
operation. Instead, it waits for more parameter input and/or the Execute Code. Suppose you change
your mind and decide that you wanted the automatic linear stretch after all. You could type on the
command line: 

        -H L -.

The newly-specified value would replace the one you typed in previously. The Execute Code would
cause Dragon to start the actual processing for the display operation. 

Note

Dragon allows you to use <F1> in the Command mode as an alternative to -. to provide
consistency with the menu mode. The dash-dot Execute Code is the only way to start execution
from inside a command script, however. 

The examples above demonstrate how Command mode input strings are constructed. A full command
requesting an operation will consist of the command for that operation, a set of p-specifiers, each
followed by its value(s), and finally, the Execute Code. You can insert carriage returns anywhere in
that sequence, except between a p-specifier and its corresponding value. P-specifiers must always be
on the same line as their associated values, separated by at least one space. 

The specific commands and p-specifiers associated with each Dragon operation and parameter are
shown in the corresponding Help messages. (To see the help for the operation as a whole, including
the command, place the mouse cursor on the response panel title. This information is also documented
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in the "Details" section associated with each operation. 

Sometimes you will want to repeat a previously-entered command, perhaps with a few changes.
Pressing the up-arrow or down-arrow keys allows you to sequence through the entire command
history. If you press up-arrow in the command line, Dragon displays in the command line the text of
the previous command or partial command that was executed. If you press the down-arrow key, 
Dragon displays the next line from the history. When you get to the first or last lines in the history,
continuing to press the arrow key will not change the text displayed in the command line. 

Note that the history will contain the command-line equivalent of all the commands you have executed
in this Dragon session, whether in Menu or Command mode. Thus, you can use the command
constructed in response to a Menu-mode operation as the basis for a Command-mode operation (by
recalling the earlier command into the command line as described above). 

You may notice that when it constructs commands in response to Menu-mode interactions, Dragon
places all parameter values in quotes. This is perfectly legal; you do not have to remove the quotation
marks. 

1.4.5 Script Mode Operation

A Dragon script is a normal text file that you create with a text editor program. Script files hold 
Dragon commands, in exactly the same format you would use in Command mode. A script can
contain a single command or a long series of commands. There are a few restrictions on what can be
done in script files, but for the most part, if you can use Command mode, you can use scripts. 

To actually execute a script, you can type the at-sign character on the command line (@) followed by
at least one space and then the name of the script file, e.g.: 

        @ MYCLASS

This starts Dragon reading and executing the commands in the file MYCLASS.SPT. (Dragon knows
that script files have the extension .SPT and looks for this script in the default data directory since you
did not specify any drive or path.) Dragon continues executing commands in this script until it reaches
the end of the file, then it returns you to normal Command mode. 

Note

You can also use the keyword RUN as an equivalent to @, for example: 

        RUN MYCLASS

You can also run a script using the Run menu item under the Script submenu of File. 

Scripts can be used for many purposes: to automate a series of operations that are performed
frequently, to create "packaged" command sequences for limiting the typing required from novice
users, and to create demonstrations and interactive tutorials. 

There are three limitations of scripts of which you should be aware: First, you cannot "nest" scripts.
That is, you cannot use the at-sign inside a script, to access another script. Second, all commands and
p-specifiers (but not necessarily parameter values) in the script file must be in upper case (capital)
letters to permit Dragon to recognize the commands. Finally, there are a few operations in Dragon
which are so interactive that it would be meaningless to execute them in script mode. These operations
cannot be included in a script file. 
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1.4.6 Interacting with the Viewports

As discussed earlier in this chapter, Dragon provides two special windows called viewports which are
used to display images. Viewports have their own menu bars and some specialized functionality,
which is discussed in this section. 

Most operations in Dragon finish by displaying an image which holds the results of the operation. In
many cases, you can decide whether the results should be shown in Viewport 0 or Viewport 1. 

Dragon will normally size the viewport to show most or all of the image data. However, you can
manually resize the viewport to make it smaller. In this case, scrollbars will appear, which will allow
you to view the entire image contents. 

The Zoom menu allows you to control the degree of magnification of the image. There are three items
on this menu which are initially enabled when an image is displayed: 

Magnify 3x 
Enlarge 
Overview 

The first two items enlarge the image, so that you can see more detail. To do a 3x zoom of the image,
select the Magnify 3x item, then use the mouse to select the location on the image that you want to be
in the center of the zoomed image. To zoom to an arbitrary expansion factor (up to 10x), select 
Enlarge. Dragon displays a dialog for you to enter the desired zoom factor. After typing a number
between 1.0 and 10.0 and clicking the OK button, click on the image to select the center of the zoom
area. 

The third item reduces the image until it fits in the current size of the viewport. In contrast to the
previous two menu options, Overview does not require any interaction. As soon as you select the
menu item, the image will be shrunk to fit the viewport size and displayed. 

After you zoom in or out, the viewport disables the three menu items listed above and enables the 
Restore option. Thus, you cannot do multiple successive zooms. If you enlarge the image to an
arbitrary factor, and want to zoom in further, you need to restore the image to normal resolution first,
and then re-execute the Enlarge option using a different magnification factor. 

Choose the Restore menu item to redisplay the image at full resolution. 

The viewports provide facilities for printing the current image, saving it to a file, or copying all or part
of the image to the clipboard. All these capabilities are accessible through the File menu on the
viewport. 

To print the currently-displayed image, choose the viewport File->Print  menu item. Dragon will
display a standard Windows print dialog, allowing you to select a printer where the image data should
be sent. Obviously, your printer must have color capabilities if you want to correctly represent a color
image. Almost any printer will do a reasonably good job with a gray-scale image. 

To save the current image in TIFF format, a format that can be imported into most graphics and
word-processing programs, choose File->Capture. The viewport will display a file selection dialog so
that you can browse to the location where you want to save the image, and enter a filename. When you
click on the Ok button on the file dialog, the viewport will convert the image contents to TIFF format
and save them in the designated file. 
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To capture all or part of the image to the Windows clipboard, chooose File->Copy. If you want to
copy the entire viewport to the clipboard, press <F1>. Otherwise, place the mouse cursor on the image
at the upper left corner of the area that you want to capture. Press the left mouse button, and drag the
mouse to the lower right corner of the area you want to select. A flexible box will follow the mouse.
When you release the mouse button, the box will disappear. The viewport will copy the data included
within the box to the clipboard. From there you can past the data into graphics programs or word
processing documents. 

The viewport also offers a Help menu. In this menu, the Help->Program item displays an "About
Box", showing the program’s version and copyright information, as well as information about
contacting the manufacturer. The Help->Status item pops up a text box with a variety of useful
information about the currently displayed image, including its dimensions. 

At any time that there is an image displayed in a viewport, you can find out the X (pixel) and Y (line)
coordinates of any point in that image. As you move the mouse cursor over the image, two fields at the
bottom right of the viewport display the continuously updated coordinates of the cursor. 

On the other hand, the viewport only accepts point selections (clicks) at very specific times in the
processing sequence. If you try to select a point on the image when the viewport is not accepting
points, the viewport will beep. You should note that some of the interactive operations, such as
training and vector definition, will not accept points until the button panel and any other subsidiary
controls are visible. This sometimes takes a few seconds. 

1.5 Commands Used Throughout Dragon 

There are a few commands or control keys that can be used in all operations or sub-menus within 
Dragon. Some of these commands have been discussed before in other contexts, but all are included
here for for reference. 

1.5.1 Commands for Operation Control

Several control key sequences are used for special purposes when you have selected an operation and
are entering parameter values. These control sequences are effective in either Menu or Command
mode. 

Press <F1> or <Ctrl-E>  to begin execution of the current operation. (Typing -. in Command
mode has the same effect.) These key sequences are also used to accept the current values and
dismiss a sub-panel. 
Press <F2> or <Ctrl-N>  to switch from Menu to Command mode or vice-versa. 
Press <F3> or click on the downward pointing triangle in a response panel field to get a list of
possible values for that field, or to bring up a file selection dialog, for filename fields. 
Press <F4> to switch the multifunction text area in the user interface so that it displays Help
messages for whatever field is currently under the mouse cursor. 
Press <F6> to switch the multifunction text area in the user interface so that it displays the
current system status information. 
Press <F7> to switch the multifunction text area in the user interface so that it displays history of
recent commands and messages. 
Press <F10> or <Esc> to cancel the current operation and remove the current response panel
from view. These key sequences are also used to cancel and dismiss a sub-panel and return the
value in the controlling field to its default. (Note that if you select a new operation from the menu
while a response panel is displayed, this effectively cancels the previous operation as well.) 
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All control keys (those that start with <Ctrl->  in the text) are entered by pressing down the key
labelled <Ctrl>  and the corresponding letter key simultaneously. 

1.5.2 Picking Points on Images

There are several Dragon operations where you must move a graphics cursor around in the viewport.
These include training area definition, coordinate display, color scheme assignment, and most
Geometry operations. There are two ways you can control the movement of the cursor that represents
your "current" position. 

The easiest way is to use a mouse. Dragon can use almost any mouse or trackball for cursor
movement, and the mouse can be used interchangeably with the keyboard. Dragon does expect that
your mouse will have at least two buttons (referred to in this manual as the left and right mouse
buttons). 

Instead of using a mouse, you can use the arrow keys available on the keyboard of most personal
computers. There are usually four arrow keys, pointing up, down, left and right. Each time you press
an arrow key, the cursor will move in the corresponding direction. 

Once you have the mouse in the desired position, you can select a point by clicking the left mouse
button, or by pressing the <Ins> Key on the keypad. 
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